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Heatmap question type.

When To Use It

Use the Text Highlighter when you want to gather feedback on text. This question type is great for
getting insights on marketing content, a written advertisement, or any other piece of text.

Your respondents can highlight a piece of the text, categorize it according to your answer options,
and provide comments to further explain their answer(s).

Setup
1. Click the Question link on the page where you would like to add the Text Highlighter question.

2. Select Text Highlighter from the Question Type dropdown and enter your overall question text.

Question Type
&7 TextHighlighter -
-
What question do you want to ask? Require this question

Please highlight specific text to provide feedback regarding how it makes you feel (positive or negative). Please
comment with the reason for your selection.

3. Click into the Text Content field to add the text sample that your respondents will be
evaluating. The text can be typed in or pasted from an external source. HTML code is not
supported in the Text Content area, however line breaks will be honored.


http://survey.alchemer.com/s3/2949116/Text-Highlighter-Question-Type
https://app.alchemer.com/t/Mjk0OTExNg%253D%253D:NDRlY2IyMjhkNTU3ZGI0MmIwNGQ5NzEwYTk3NDQ0MjY=/0/0/0
http://test-copy-alchemer.knowledgeowl.com/help/image-heatmap-question-type

What question do you want to ask?

Please highlight the text where you feel negatively or positively on the statements below. Provide a comment for your scoring:

Require this question

Apply data retention policy to this question's responses. Learn more.

Text Content

We are a company dedicated to making our customers more successful.

We do this in unigue and unexpected ways, from making our platform accessible to anybody (even including visually
impaired survey creators and takers) to custom-building integrations that allow companies to act first and analyze later.
Everything springs from our three core values.
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4. Customize your Multiple Choice Options as well as their associated colors. Choose the color by
clicking on the color selector located to the left of the answer option (highlighted below). This
will be the color of the highlight visible to your respondents after they have selected a piece of
text and an option to categorize that text.

Mu Hjlp|e Choice Options Common Answer Library Advanced Option Settings
OPTION

. postitive
. negative

+ Click to Add Option Paste in Options

Note: If your Text Highlighter question contains only one option, that option will be
automatically selected when the respondent highlights a piece of text.

Text Highlighter Settings

There are several settings available to help you further customize your Text Highlighter question.

Allow Multi-Select

The Text Highlighter question allows for a multi-select option. When Allow Multi-Select is
enabled, multiple answer options can be associated with a single highlight. For example, you may
be evaluating text for spelling and grammar mistakes. It's possible that a particular word has both
a grammar and spelling error and respondents should be able to select both reasons for
highlighting the word.



Please identify spelling and grammar errors in the following sentence. Highlight the text that contains the errors and indicate whether the error
is spelling, grammar, or both.

Do this sentance haz any spelling and gramar errors? Please let us know!

Select an option to provide feedback

To enable multi-select, edit the Text Highlighter question and navigate to the Logic tab. Select
Yes under the Allow Multi-Select section.

Text Highlighter

Question Logic Validation Layout

Logic Rule

Only show this question based on answers to previous questions or other logic conditions
Hide all subsequent questions on this page

Hide this question by default (mainly used with custom scripting)

Only show this question to admin users

Disable Question

Yes
© No

Allow Multi-Select
O Yes
No

Text Highlighter Comments
The Text Highlighter question allows you to gather comments on highlight selections (the
comments can also be required). These options are available on the Layout tab.

Note: Comments are enabled by default.

Text Highlighter

Question Logic  Validation

Additional Instructional Text

Show instructions above the question title

Text Highlighter Comments

Allow comments on text highlights

Require comments on each highlight




Validation Options
There are a couple validation settings that you may want to utilize in the Text Highlighter
question. These settings are available on the Validation tab when editing the question.

Max Character Count Per Comment:

Max Highlights / Points Per Response:

If you have enabled comments on your question's Layout tab, you can limit the number of
characters that can be entered by your respondents into the comment field. Once enabled, a

comment box is available for each highlight.

You can also limit the amount of unique highlights that a respondent can make on your text
sample. Simply specify a number in the Max Highlights / Points Per Response field.

Note: Both the Max Character Count and Max Highlights Per Response options are blank by
default.

Customize Instructions
After highlighting a piece of text, respondents will see the following default instructions:

Customer travel experience

2. Please highlight the text where you feel negatively or positively on the statements below. Provide a comment for your scoring:

We are a company dedicated to making our customers more successful.
We do this in unique and unexpected ways, from making our - . Shally impaired survey creators and takers) to
custom-building integrations that allow companies to act first EWLM core values.

) Dislike

—

You can customize these instructions via Tools > Text & Translations. Click on the language
version that you wish to edit and locate the specific Text Highlighter question that you want to
customize. Click edit and update the text in the Comment Description field.

Note: To translate the Save and Cancel button text, head to Tools > Text & Translations and



navigate to the Save & Continue tab. Locate the Save and Cancel buttons in the list and
make your customizations before saving.

Survey Taking
On a desktop and most laptops the Text Highlighter question type looks like so.

2. Please highlight the text where you feel negatively or positively on the statements below. Provide a comment for your scoring:

We are a company dedicated to making our customers more successful.
We do this in unique and unexpected ways, from making our n P jally impaired survey creators and takers) to
custom-building integrations that allow companies to act first ¢ Like core values.

@ Dislike

=

Highlighting a piece of text will trigger a pop-up window with the highlight options and comment
field. Clicking Save will capture the highlight selection.

Mobile Interaction
The Text Highlighter mobile interaction is worth noting. The respondent will make their selection
by touching the image on their mobile device.

For highlighting a single word, the respondent can touch the word to highlight it, at which point
the options and comment field will be presented. For highlighting multiple words or sentences, the
respondent will need to press and hold the device's screen to trigger the device's native
highlighting options. Once the highlighting tools are available (see image below), the respondent
can drag the end-points to select the desired text.



Customer travel experience

2. Please highlight the text where you feel negatively or positively on the statements below. Provide a
comment for your scoring:

We are a company dedicated to making our customers more successful.

We do this in unigque and unexpected ways, from making our platform accessible to anybody (even

including visually impaired survey creators and takers) to Select an option to provide feedback
companies to act first and analyze later. Everything sprinc Like

) Dislike

Reset Highlights
Should a respondent need to remove any already highlighted points, they will need to utilize the
Reset Highlights option available at the bottom right corner of the Text Highlighter question.

Powerful Salesforce integration
Robust multi-user options

Secure Single Sign-On capabilities
Access to our advanced API

Personalized Training Options

Our Account Managers are standing by to identify the features and services you need, ensuring that your Enterprise account is perfectly
tailored to your organization.

Reset Highlights

Reset Highlights will remove all highlights from the question. Highlights cannot be removed
individually.

Reporting

The Text Highlighter question reports as a heatmap element showing aggregated data of your
respondents' highlights. The areas of your text sample with a high density of respondent
highlights will be indicated by color intensity (the darker the color, the more respondents have
highlighted that area relative to other areas of the text sample). The most highlighted word per
answer option, will display in white font.



View Answer Option: | Like = English ~
W EE T Eihistorian and storyteller working with and for the community.
For more than thirfy years. Levine Museum of the New South has served the region as histerian and storyteller of the post-Civil War era. Working and learning alongside

members of the community, we tell the stories of our past through I rogramming. exhibits and events, furthering dialogue that fosters empathy and inspires
action toward

fore connected and inclusive community.

Value

Percent Count

Like I 87.9% 138
Dislike || 121% 19
Totals: 157

Hide Responses »

Most Frequent Word Per Answer Option

The reporting element allows you to toggle between your Text Highlighter options to view the
highlight distribution per option (for example, positive or negative). You can also toggle the
language version of your text sample if you have created translations for your survey.

2. Please highlight the text where you feel negatively or positively on the statements below. Provide a
comment for your scoring:

View Answer Opt'io English «

Like
We are a company ded Dislike imers more successful.
We do this in < empmseemene Making our platform accessible to anybody (even including visually impaired survey

creators and takers) to custom-building integrations that allow companies to act first and analyze later. Everything springs from our
three core values.

Value Percent Count
Like PN 100% 2
Dislike 0% 0

Totals: 2

Show Responses ¥

You also have the ability to view highlights and comments in greater detail (these details can be

toggled via the Show/Hide Responses options and display 20 selections per page). The details are
hidden by default.

Hide Responses v
iD Color Choice Selection Comment
1 m postitive "Salesforce integration” Amusthave
1 . postitive "Salesforce integration" Good to know that this is available.
1 . postitive "Salesforce integration” Salesforce Integration is very important
for our org.
2 =] postitive "API" Very cool!

© See additional compatible chart types



© See what other report types are compatible

Exporting
The Text Highlighter exports the highlighted text in quotes and its corresponding comment

separated by the pipe symbol (if available). Each answer option will have its own column in the
export.

| v | w [ x [ ¥ ]
postitive:Please highlight specific text to prc negative:Please highlight specific text to provide feedt
"Salesforce integration": Salesforce Integration is very important for our org. | "Salesforce integrati
"API™: Very cool!

"Secure Single Sign-On capabilities”: Our company uses this, good to know it's available. | "contract

The export format is as follows:

"Highlighted Text": Associated Comment | "Second Highlighted Text": Associated Comment,
etc.

Limitations

e HTML is not supported in the Text Content area, however line breaks will be honored.
e The Text Highlighter question is not compatible with Offline Mode.
e The Text Highlighter is not compatible with PowerPoint exports of Standard Reports.

A Note About Text Highlighter Data

Editing your Text Highlighter text sample after collecting survey responses is highly
discouraged as it will result in invalidating your data. You will see the following alert when
editing the highlighter question after data collection:

Text Content

We are a company dedicated to making our customers more successful.

We do this in unique and unexpected ways, from making our platform accessible to anybady (even including visually
impaired survey creators and takers) to custom-building integrations that allow companies to act first and analyze later.
Everything springs from our three core values.

N

Warning! This survey has responses.

If you change the text content after you have collected responses, the data for the previously collected responses will become
unusable. We recommend that you copy this question, then disable the original to make any edits.

If needing to make an edit to the Text Content, it is recommended that this question is copied
and edits are made in the copy. The original can then be disabled.



Please refer here for best practices on editing a live survey.

Net Promoter®, NPS®, NPS Prism®, and the NPS-related emoticons are registered trademarks of
Bain & Company, Inc., Satmetrix Systems, Inc., and Fred Reichheld. Net Promoter Score* and Net
Promoter System * are service marks of Bain & Company, Inc., Satmetrix Systems, Inc., and Fred
Reichheld.
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